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● PC requirements for the Control Software 

● For Window Vista users:  How to change start-up settings in the Control Software

OS : Windows XP, Vista, Windows 7
　　 ＊Windows XP SP2 or higher
　　 ＊Vista users will need to change the start-up settings for the Control Software.
　　 ＊Your security software may delete the Control Software or prevent you from launching it. 
　　　If these things happen, please consult the security software instructions.

CPU: With specifications sufficient for smooth operation of the installed OS
Memory: With memory capacity sufficient for smooth operation of the installed OS
Recommended display: 65,000 colors or more. 
　　　　　　　　　　　　800 x 600 pixels or higher resolution.

Right-click the Control Software 
icon to show the pop-up menu.

１

２

３
４

Select compatibility tab.
Check "Start this program in compatibility mode."
Check "Execute this program as an administrator."
Click "Apply"

＊A user account control warning message may appear 
  when you start the Control Program.  If this happens, 
  give the program permission to start.

-１-

１. About the Program Control Tracer 

The program control tracer operates in two different modes.

・Programming mode

・Line tracing mode

The program control tracer will follow the moves you programmed. Use the dedicated software to program 
your robot. 

In line tracing mode, the program control tracer moves along a course. It uses optical sensors to detect black 
course lines.

１

２

３

４

Open (O)
Run as Administrator (A)
Enable/Disable Digital Signature Icons
Media Info

Properties

Program
Control Tracer
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・Example course

White

Black

20mm

10
0m

m
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・How to create a line tracing course

You can download a course sheet for line tracing mode from Artec's web site. 
You can also create your own course.

・How to get a course sheet for line tracing mode

When the right-hand sensor detects a black line, it knows that the course travels to the right. It stops the 
right-hand motor, allowing the left-hand motor to turn the robot to the right.
When the left-hand sensor detects a black line, it knows that the course travels to the left. It stops the 
left-hand motor, allowing the right-hand motor to turn the robot to the left.
When both sensors detect a black course line, the robot knows that the course ends and stops both motors.

・How the Program Control Tracer works

The optical sensors mounted on the sensor circuit measure the 
intensity of light reflected from the ground. The intensity 
of light reflected from the black course line is different from that reflected from a white surface, 
The sensor identifies the course line by detecting the difference in light intensity. 

・How the optical sensors work

Use the included "course sheet" for line tracing experiments 
to verify that the tracing robot functions properly.

Operate the robot in line tracing mode

２. Line Tracing Mode

Use a black marker to draw a 20mm-wide course line on a sheet of white paper. Let the program control 
tracer run along the course.
The program control tracer cannot follow sharp turns or small curves with a diameter of 100 mm or less. 
To prevent the robot from running astray, keep these things in mind when you make your own course.

If you draw a circuit course, the program control tracer will keep 
running. Draw a circuit course like the one in the figure to the left. Draw 
a black line along the edges of the paper to catch the robot if it strays.
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・How to use line tracing mode

Touch the sensor with your 
fingertip until you hear a beep.

Turn the power ON.

● The tracing robot does not move.
 → The programming mode might be activated. Turn the power OFF and ON again with a finger resting 

on the touch sensor.

 → The touch sensor may not detect dry fingertips. Moisten your fingertip with water.

 →

 →

In the line tracing mode, the program control tracer uses the optical sensors to detect the intensity of reflected light. 
Because the sensors are susceptible to the surrounding environment, perform the experiment under constant lighting 
conditions. If the room is too bright, the sensors may not work properly. Do the experiments in a room with the 
ceiling light ON and the curtains closed. Make sure no part of the course sheet is shaded by anything, as this may 
affect the operation of the sensors.
Adjust the optical sensors properly. Refer to the assembly instructions for the adjustment procedures.

● The line tracing mode cannot be activated.

● The tracing robot does not follow the line.

Troubleshooting

Place the robot on the black line, matching up the robot body and the line.
Course sheet for the line tracing mode

＊The touch sensor is a short-circuit switch. The circuit is completed when a finger 
bridges the gap between the lead wires.

＊The touch sensor may not detect dry fingertips. Moisten your fingertip with water. Be 
careful not to get the circuit board wet or it may be damaged.

-3-

Place a course sheet for the line tracing mode on a flat surface. Place the 
robot on the black line, matching up the center of the robot body and the 
black line. (Make sure neither of the sensors lie above the black line.)
Switch on the power while one fingertip rests on the touch sensor. You will 
hear a beep when the line tracing mode is activated. (Keep your fingertip 
resting on the touch sensor until the beep ends.)
When you take your finger off the touch sensor, you will hear a short beep 
and the tracing robot will start moving. Let's see whether the tracing robot 
follows the line and stops successfully.
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３. Programming Mode

Insert the CD-ROM into the CD (or DVD) ROM drive of the PC. Drag & drop the 　　 icon onto the desktop.

Double click the 　　 icon to open it. 

Visit Artec's web site (http://www.artec-kk.co.jp/pct), download the Control Software and 
place it on the desktop. Double click the 　　 icon to open it. 

・Exiting the program control tracer Control Software.

The figure above shows the screen you will use when creating your own control program.
To write a program, just drag & drop icons to the programming area.
You can place 24 icons on the Routine tab and 8 icons on each of the Subroutine tabs.
The tasks specified by the icons will be executed in numerical order. 
You can transfer your completed program from the software to the robot via optical communication. 

Program
Control Tracer

Program
Control Tracer

Program
Control Tracer

Select the "File" menu. Select "Exit" to end the Control Software.

Program Control Tracer
File (F) Edit (E) Run (R) Help (H)

●Instructions for installing the Control Software from the Internet.

・Programming Screen

● Instructions for installing the Control Software from the CD-ROM.

Use the software to create a program for the robot
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Time Optical sensorData Transfer Area Motion Commands

Program Control Tracer
File (F) Edit (E) Run (R) Help (H)

Right turnLeft turn

Pause

Go 2.0 Sec. 3.0 Sec.

4.0 Sec. 5.0 Sec. 6.0 Sec.

7.0 Sec. 8.0 Sec. 9.0 Sec.

Both BothOne side

One side Left side Left side

Right side Right side Sensor calibration
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④ ⑤ ⑥

⑦ ⑧ ⑨

1 2 3 4 5 6 7 8

Routine Subroutine 1 Subroutine ２

Programming Area

Programming Icons
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Data
Transfer
Area

メニュー転送位置
Open (O)
save as (S)

exit (X)
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・Program Control Tracer: Control Software icons 

Basic operation icons

Advanced operation icons

-５-

●Configure icons You can change the set values of the time-related icons ①-⑨ and the repeat icon. Double click 
the icon to show the pop-up window. Change the set value and click "OK" to change the setting.

Set the time period The number of repeats
You can specify between 1 and 255 repeats.
The minimum unit is one.

005 times
repeat Touch sensorSubroutine

１
Subroutine

２Repeat
start

Start repeating a 
part of a program 
from this point. 

Allows you to 
insert a certain 
action sequence 
in your program.

Pause the program.
Use the touch sensor 
to end the pause.

Allows you to 
insert a certain 
action sequence 
in your program.

Stop repeating 
here.

Both

One side

Both

One side

Left side

Left side

Right side

Right side

Sensor calibrationGo

Right turn

Left turn

Pause

1.0 sec

①

9.0 sec

⑨

Motion icons Time-related icons Sensor-related icons

Go

Right turn

Left turn

Pause

Until both sensors 
detect white color

These icons are needed to write programs that use the optical sensors. 
(See "6. Programs using the optical sensors," on page six.) 
The sensors use the light intensity of the starting point as a reference 
value. Light intensity values the same or higher than the reference value 
are considered white; values below are considered black. 

Until either of the 
sensors detect 
white color

Until both sensors 
detect black color

Until either of the 
sensors detect 
white color

Until the left 
sensor detects 
white color

Until the right 
sensor detects 
white color

Until the right 
sensor detects 
black color

Until the left sensor 
detects black color

There are nine time 
setting icons.
By default, time 
periods from 1.0 to 
9.0 seconds are 
allocated to the 
icons.
To change the time 
period, double click 
the time setting icon. 
A time settings 
pop-up menu will 
appear. From here 
you can set the time 
period  between 0.5 
and 25.5 seconds, in 
0.1 second 
increments.
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Using the time setting icons, you can set nine 
different time periods between 0.5 and 25.5 
seconds. The minimum unit is 0.1 second.



４. How to Use the Control Software

・Creating a Control Program

・Useful Functions

You can edit icons placed on the Routine.

To show the edit menu, right-click on the 
icon you want to change.

File → Open : Opens saved data.
File → Save As：Saves created program.

Delete (X)

Delete a column (Y)
Add a column (Z)

Edit menu 

Drag and drop basic / advanced icons onto the Programming Area to create a program. Place repeat 
icons on "Row A". Place motion icons, Subroutine 1 & 2 icons, and Touch Sensor icons on "Row B". 
Let's practice creating a program. Drag & drop the "GO" icon onto the first row of the Routine.  When 
you place motion icons, a time setting icon will automatically appear below them on the second row. If 
you want to change the default time icon, replace it with a different one.

-６-
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Program Control Tracer
File (F) Edit (E) Run (R) Help (H)

Pause

Go

Right turnLeft turn 6.0 Sec.

7.0 Sec. 8.0 Sec. 9.0 Sec.

Both BothOne side

One side Left side Left side
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③
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④

5.0 Sec.

⑤ ⑥

⑦ ⑧ ⑨

1 2 3 4 5 6 7 8

Routine Subroutine 1 Subroutine 2

Row B
Row A

Row C

Go

Go

1.0 Sec.

①

2.0 Sec.

②

Drag & Drop

1 2 3 4 5

Routine Subroutine 1 Subroutine 2

Go

1.0 Sec.

①

Right turn Left turn

3.0 Sec.

③

2.0 Sec.

②

"Delete" removes an icon.

"Delete a column" 
removes a column, pulling the 
remaining columns to the left.

"Insert a column" 
puts a new column in 
between two existing ones.
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①
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③

Go
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④

1 2 3 4 5
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Go
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①

Left turn
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③

Go
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④
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Go
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①
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・Useful Functions

● Text example

５. Transferring a Control Program 
How to transfer a control program

Troubleshooting data transfer problems:

-７-

・ Close curtains to shut out strong light coming in through the windows.
・ Darken the room by turning the light off.
・ Angle the computer screen to your side.
・ While holding the sensor on the data transfer area with one hand, shade it with a notebook or piece of cardboard.
・ Use the included optical sensor protective cover to shut out unnecessary light.
・ Adjust the brightness and contrast of your computer screen, according to the manufacturer's directions.
　(Optimal settings may vary depending on the monitor type and compatibility with the optical sensor.)

Edit → Reset  : Start over with a new program

Edit → Reset times: Resets all time settings to default without deleting 
　　　  an existing program

Edit → Display text : Shows a readable text version of the program 
　　　  you created.

1 2 3 4 5 6 7 8

Routine Subroutine 1 Subroutine 2

Go GoTouch sensorSubroutine

１
Right turn Left turn

Sensor calibration 5.0 Sec.

⑤

Both

● Example Routine

The control program you created on the PC can be transferred to the robot via optical communication. 
To ensure proper data communication, keep the computer screen out of strong light. Make necessary lighting 
adjustments if the robot has difficult seeing the flashing lights. It may help to cover the sensor with your hand.
Please note that the following may affect data transfer:
-Light shines through a window onto the computer screen.
-Bright lights or lamps are reflected in the computer screen. 
-The computer screen has a high-gloss surface, excellent color performance, or high contrast. 

The optical sensor protective cover is 
printed on the back of the assembly 
instructions. Cut it out and place it on a 
sheet of cardboard. Cut the cardboard to 
match. Glue and assemble the cover.

Cardboard

Data Transfer AreaData Transfer Area
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Start motion sequence

Basic motion
01. 　Repeat start: NO 　　　　　　　　Calibrate the sensor
02. 　Repeat start: NO 　Go　　　　　　5.0 S
03. 　Repeat start: YES　Right turn　　1.0 S
04. 　Repeat start: NO 　Subroutine１ 

Subroutine 1

Basic motion
05. 　Repeat start: NO 　Touch senser 
06. 　Repeat start: NO 　Go　　　　　　6.0 S
07. 　Repeat start: NO 　Left turn 　　4.0 S

End motion sequence



Program Control Tracer

Place icons on the Routine. When you complete your program, 
transfer it to the program control tracer, following the procedures below.

Data Transfer Area

You will see a progress bar and 
hear an occasional short beep or 
chirping sound while the program 
data is being transferred.

After you complete a successful data transfer, return the sensor board to the main body. 
Tap the touch sensor to execute the program.

-８-

① Remove the optical sensor from the program control tracer.

② Put the optical sensor on the data transfer area.

Press down the rivet collar and remove the rivet from 
the back of the sensor board.

③ From the Run menu, select the "Transfer" option.

④ When the Data Transfer screen pops up, turn ON the program control tracer and listen for a long beep. 
　 Make sure to keep holding the optical sensor on the Data Transfer Area.    

⑤ Click "OK" on the Data Transfer screen to start the data transfer.

⑥ When the data transfer is completed, you will hear a long beep and the programming screen will reappear.
　 ＊You will hear no beeps or chirps if the data transfer fails.
⑦ Return the sensor board to the main body.
⑧ To execute the control program, tap the touch sensor on the main circuit board with your fingertip. 
⑨ To repeat the same program, tap the touch sensor again. 
⑩ When you turn the power OFF, the program data in the robot will be erased.

1 2 3 4 5

Routine Subroutine 1 Subroutine 2

Go

1.0 Sec.

①

Right turn Right turnLeft turn

3.0 Sec.

③

2.0 Sec.

②
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4.0 Sec.

④
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⑤
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Make sure the sensors are right above the white circles 
in the black squares. If the sensors and the circles are 
not aligned, adjust the position of the black squares 
with the bar at the bottom of the Data Transfer Area.

Transfer (T)
File (F) Edit (E) Run (R) Help (H)
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Measure the distance traveled in a given unit of time Measure the time needed to travel a given distance

Two different measurements

By performing these experiments, you will understand the capabilities of the robot.

Measuring straight movement

６. Measure the Movement of the Program Control Tracer
The motor-integrated gear boxes control the motion of the program control tracer. The performance of individual gear 
boxes may vary. If the two gear boxes provide different performance, the robot may veer slightly as it travels forward. 
Performance is also affected by the state of the batteries. 
It is recommended that you fine tune your program for optimal performance. To determine what adjustments are 
needed, create a test program with the Control Software and let the robot run on the measurement gauges＊. Adjust 
your program based on the measurement results.
＊Please use the measurement gauges on pages 11 and 12. 

Create several control programs that make the robot move straight. Use the gauge ruler on page 11 to 
measure the following:
 -How many seconds does it take for the robot to travel a given distance?
 -How far can the robot travel in a given time period?
Use the table on page 11 to record the results.

Measuring a turn
Create several control programs that make the robot execute left or right turns. Use the protractor 
on page 12 to measure the following:
 -How many seconds does it take to turn the robot to a given target angle?
 -How far can the robot turn in a given time period?
Use the table on page 12 to record the results.

1 2 3 4 5 6 7 8 9

10

111213141516171819
0 1010

2020
3030

40
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50
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80
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＊Download a course sheet for the programming mode from Artec's website.

How to use the course sheet

7. Operate the Program Control Tracer on a course sheet 

Create a control program that makes your robot to travel from the Start, through the Turn areas, and arrive at the Goal.

To create a program that uses the optical sensors, drag & drop the 
　　icon onto the first column in row C.

Utilize the optical sensors 

①

②

④

Starting point

⑤

③

-１０-

● Example Routine

When the above program is executed, the sensors will calibrate by 
measuring the light intensity of the start point. They use this measurement 
as a reference value. Light intensity values the same or higher than the 
reference value are considered white; values below are considered black. 
The larger the difference between black and white, the easier it is for the 
sensor to detect the course line.

① The Sensor Calibration icon instructs the robot to calibrate the light 
sensors. Once this is done, it moves to the next step in the program.

② The robot goes straight until both sensors detect black, then it proceeds 
to the next step.

③ The robot keeps turning right until the right sensor detects white color, 
then it proceeds to the next step. 

④ The robot keeps turning left until both sensors detect black, then it 
proceeds to the next step.

⑤ The robot goes straight until it detects white. The program is complete.

Sensor calibration
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Row B
Row A

Row C

1 2 3 4 5 6 7 8

Routine Subroutine 1 Subroutine 2

Go GoRight turn Right turnLeft turn
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Routine Subroutine 1 Subroutine 2

Go GoRight turn Right turnLeft turn

８. Other functions

This function allows you to repeat a portion of your control program. Bracket the desired portion between 　　 icons on Row A. 
Place a Repeat icon at the beginning and a 　　 icon at the end of the portion to be repeated.

● Example routine - Repeat commands between the second and fifth columns.

● Example Subroutine

＊The repeat function is applicable to two or more commands. 
　You cannot repeat just one command.

The Touch Sensor icon pauses the program execution. Define where to use the Touch Sensor by placing the Touch Sensor icon on Row B. 
The robot pauses the program at the position you placed the Touch Sensor icon. Tap the Touch Sensor to resume program execution.

● Example Routine

You can specify between 1 and 255 repeats.

Double click the 　　 icon to show a pop-up window. 

-１１-

Place a Repeat icon before the beginning and a Repeat-005 icon after the end position.

Advanced operations
Using the Repeat function

How to use the Subroutines

How to use the Touch Sensor icon

Setting the number of repeats

Row B
Row A

Row C

Row B
Row A

Row C

Row B
Row A

Row C

005 times
repeat

005 times
repeat

Repeat
start

Use the Subroutine 1 & 2 tabs to program a list of commands to be called from the main Routine tab. Click the Subroutine 1 tab to 
show its programming area. Place icons on the Subroutine in the same manner you did on the Routine. The Repeat, Subroutine, and 
Touch Sensor icons are not available on the Subroutine.
When you finish placing icons on the Subroutine, go back to the Routine tab. Define where to execute the subroutine by placing the 
Subroutine 1 icon on Row B. (You can create and insert a Subroutine 2 program in the same manner as the Subroutine 1.)
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９. Troubleshooting

-１２-

● The robot does not move.
・Batteries may be drained. Replace old batteries with new ones.
・Check if the robot is assembled properly, reading the assembly instructions carefully.
・Check if all wires are connected properly. Solder the conductive wires, if necessary, to complete the wiring.

● The wheels rotate in the wrong direction.
・Compare the robot to the assembly instructions. Ensure that the gear box is properly mounted.

・Refer back to the assembly instructions. Verify that the circuit board is 
　properly assembled and that the wiring is correct.
・Check all the parts with polarity (+ / -) to see if they are attached in the proper orientation. 
　Carefully consult the assembly instructions.
・Check whether the soldering was performed properly.
・Verify that no conductive wires are short circuited.

・The Touch Sensor may not detect dry fingertips. Moisten your fingertip with water.
  ＊Be careful not to get the circuit board wet or it may be damaged.
・The sensor may not work properly due to reduced sensitivity if batteries are drained. 
  Replace old batteries with new ones.

093558　Program Control Tracer (soldering required)

093558   Program Control Tracer (soldering required)
093559   Program Control Tracer

◎ The program does not transfer.

◎ The robot does not operate properly. 

◎ The Touch Sensor does not work.

◎ You have trouble getting the robot to use the optical sensors.

◎ The robot does not operate properly. 

・In operating these programs, the sensors measure the light intensity of the starting point and use it as a 
reference value. Light intensity values the same or higher than the reference value are considered white; 
values below are considered black.

・Make sure to keep the starting point bright enough. If the light intensity of the starting point is close to 
that of the black course line, the sensors will have reduced sensitivity, resulting in difficulty detecting 
course lines. Perform the experiment under constant lighting conditions. Make sure no part of the course 
sheet is shaded by anything, as this may affect the operation of the sensors. 

・Adjust the optical sensors properly. Refer to the back side of the assembly instructions for the 
adjustment procedures.

・The sensor may not work properly due to reduced sensitivity if batteries are drained. Replace old 
batteries with new ones.

・Adjust data transfer settings, referring to "5. Transferring a Control Program to Program Control Tracer" 
on page seven of the Control Software instructions. 

・The sensor may not work properly due to reduced sensitivity if batteries are drained. Replace old 
batteries with new ones.
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